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Navigate the Excel User Interface



Microsoft Office Excel 2021
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Microsoft Office Excel 2021 is an application that is part of the Microsoft 
Office 2021 suite of user productivity software. Excel is a powerful 
spreadsheet program that allows you to store, present, manipulate, and 
analyse various types of data. Excel's functionality enables you to work with 
and analyse massive amounts of raw data in order to obtain actionable 
organisational intelligence. This intelligence will help you make sound 
decisions to improve any number of business and organisational operations.



Spreadsheets, Worksheets, and Workbooks
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• A spreadsheet is simply a paper or an electronic document, arranged in 
tabular form, that is used to store, manipulate, and analyze data.

• A worksheet is an electronic spreadsheet that is used for entering, storing, 
and analyzing data in Excel. Think of worksheets as individual pages within 
Excel that display and allow you to work with your data.

• A workbook is an Excel file that serves as a container to store related Excel 
worksheets. Applying the individual page analogy: if the worksheets are the 
individual pages, the workbook is the binding that holds the pages together.



Excel workbooks act like binders for related worksheets
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Cells and Ranges
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An Excel worksheet is arranged in a tabular 
format, meaning it consists of a series of 
columns and rows that intersect to form 
cells. A cell is a singular container that you 
can use to input and store data. Each 
rectangle that you see on an Excel worksheet 
is a separate cell.
In Excel, a range is a contiguous group of cells that typically contains related data. A range 
can consist of an entire row or column, a group of cells in a row or column, or a group of 
cells that covers multiple rows and columns. You can use ranges to organize your 
worksheets by related sets of data.

Presenter
Presentation Notes
Cell Regions
You may also come across the term region in reference to worksheet cells. A region is simply a group of contiguous, populated cells. A region is different from a range because a range can, technically, contain blank cells, rows, or columns; a region does not.



Cell and Range References
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• Cell references: Alphanumeric values used to identify particular cells on an Excel 
worksheet. Cell references consist of a row header and a column header, which identify 
the cell at the intersection of the row and the column.

• The letter refers to the column headers in Excel, whereas the number refers to the row 
headers.

• Use range references to identify particular ranges of data in your worksheets.

• In Excel 2021, a worksheet can contain up to 16,384 columns and 1,048,576 rows. The last possible cell 
reference in an Excel worksheet is XFD1048576.



The General Excel UI
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• The Excel user interface (UI) contains all of the workspaces and commands that you will use 
to create and work with workbooks and worksheets. The general areas along the top and 
bottom of the Excel UI contain elements that display information about the current 
workbook and provide you with access to some of the more commonly used commands 
and tools.



The Workbook and Worksheet UI Elements
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• The inner part of the Excel UI displays your workbook and worksheet contents and some 
common navigation controls to help you locate and work with data.



Excel UI Element Description

Formula Bar Displays the contents of the currently selected cell in a worksheet. You can also 
use the Formula Bar to edit cell contents.

Name Box
Displays the cell reference for the currently selected cell, or the cell reference of 
the active cell in the currently selected range. The Name Box can also display 
custom range names and can be used to navigate to a particular cell.

Column headers Identify each separate column with a unique letter or letter combination.

Row headers Identify each separate row with a unique number.
Select All button Selects all cells in the worksheet.
Scroll bars Navigate vertically and horizontally across worksheets.
Worksheet tab navigation 
controls Navigate among the various worksheets within a workbook.

Worksheet tabs
Open a particular worksheet within a workbook. You can also use worksheet tabs 
to name, rename, and arrange worksheets, and you can apply certain formatting 
options to the tabs.

New sheet button Adds a blank worksheet to the workbook

The Workbook and Worksheet UI Elements
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Presenter
Presentation Notes
Each workbook file that you open simultaneously appears within its own instance of the Excel user interface, and each window displays the same commands and workspaces. You can open as many simultaneous instances of workbooks as your computer's memory can support.



Excel Window Commands
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Command Enables You To

Ribbon Display 
Options button

Change how Excel displays the ribbon in the UI. You have the following three options: Auto-hide 
Ribbon: This option hides the ribbon entirely until you select the top of the Excel UI. Once displayed, 
the ribbon remains visible until you select something outside of it.
Show Tabs: This option hides the ribbon groups and commands, but leaves the ribbon tabs visible. 
The command groups and commands appear when you select a ribbon tab and disappear again 
when you select an item outside the ribbon.
Show Tabs and Commands: This is the default ribbon display option, which leaves the entire ribbon 
on screen at all times.

Minimize button Hide the entire Excel 2021 UI. The application remains open, however, and the Excel 2021 icon still 
appears on the Windows® taskbar.

Maximize/Restore 
Down button

Reduce the size of the Excel UI from full screen to a smaller sized window, or maximize a smaller 
window back to full screen. When the window is reduced in size, you can drag the bottom-right 
corner of the UI to resize the Excel window to suit your needs.

Close button Close the currently selected workbook. If there is only one Excel workbook file open when you select 
the Close button, the entire application closes, too.



The Backstage View
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• The Backstage view appears when you select the File tab on the ribbon. Along the left pane in the Backstage 
view, Excel displays a series of commands and tabs that enable you to save and access Excel workbooks, as 
well as work with your Excel files and configure Excel application options.

Presenter
Presentation Notes
In older versions of Excel, it was easier to distinguish the commands from the tabs in the Backstage view. Starting from Excel 2019, however, tabs and commands have the same appearance.



Backstage View Element
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• Common tasks you may perform in the Backstage view include previewing and printing 
workbooks, saving and accessing Excel files, applying security options, and sharing 
workbooks with colleagues. You can exit the Backstage view by selecting the Back button 
at the top of the left pane.

Backstage View Element Description

Left pane Displays the file commands and the various Backstage view tabs.

File commands Enable you to open, close, and save your Excel workbook files.

Tabs Provide you with access to commands for working with your Excel workbooks 
and various options for configuring the Excel environment.

Right pane Displays various commands and options for working with your Excel workbook 
files depending on the tab you select in the left pane.



Navigation Option] Mouse Command
Select a particular cell. Select the desired cell.

Select a range of cells. Click and drag to select the desired range of cells.

Select an entire column or row. Select the desired column or row header.
Move the worksheet display up or down by a 
single row. Select one of the vertical scroll arrows.

Move the worksheet display left or right by a 
single column. Select one of the horizontal scroll arrows.

Move the worksheet display by more than one 
row or column at a time.

Click and drag the vertical or horizontal scroll bars to 
the desired view.

Move the worksheet display one screen at a 
time.

On the vertical scroll bar, select the area between 
the scroll bar and the desired direction's scroll arrow.

Display a different worksheet. Select the desired worksheet tab along the bottom 
of the workbook window.

Mouse Navigation

13



Icon Cursor Context/Location Description
Placed on ribbon tabs or commands, Backstage tabs or 
commands, Quick Access Toolbar commands, scroll 
bars, sheet tabs and navigation commands, and view 
and zoom controls.

Select an element to perform the associated 
action.

Placed at any edge of a cell or range of cells. Drag a cell or range of cells to move the data inside 
to another cell or range.

Placed over a cell in a worksheet. Select an individual cell, or drag to select a range 
of cells.

Placed between worksheet column headers.
Resize the column to the left of the cursor, or 
double-click to AutoFit the column to the left of 
the cursor.

Placed between worksheet row headers. Resize the row above the cursor, or double-click to 
AutoFit the row above the cursor.

Placed inside an active cell, the Formula Bar, or various 
text boxes.

Select inside a text box or the Formula Bar to begin 
typing data into it. Or, double-click an active cell to 
do likewise.

Placed at the bottom-right corner of a cell or range of 
cells.

Drag vertically or horizontally to copy or AutoFill 
data into adjacent cells.

Mouse Cursor Icons
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The Active Cell
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• When you select a cell in Excel, it becomes the active cell, and it is only into the active cell that you 
can initially enter data. An active cell is displayed with a solid green border around it.

• You can use the Tab and the Enter keys to navigate among cells within a selected range while 
maintaining the range as your selection.

• When interacting with the cells in your worksheets, an active cell can be in one of three modes: 
Ready, Enter, or Edit. Excel displays the status of the selected cell on the left side of the status bar.
• Ready mode tells you a cell is selected and that it is waiting for you to interact with it.
• Enter mode activates once you start typing data into a cell.
• Edit mode activates and allows you to enter or edit data.



Basic Data Entry
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Data Entry Method Description

Directly into the active 
cell

The most basic method of entering data into a cell is to select the cell, type the data, and then press 
either the Tab or the Enter key. Pressing Tab will enter the data and navigate one cell to the right. 
Pressing Enter will enter the data and navigate to the first open cell in the next row down.If there is 
already data in the cell, using this method will overwrite the previous data.

Using Edit mode

You can use Edit mode to either enter new data in an empty cell or edit existing data. Using Edit 
mode is more useful for editing existing data; otherwise, Edit mode is simply an extra step if you're 
just adding new data.To use Edit mode, either double-click the desired cell, select the desired cell 
and then place the insertion point in the Formula Bar, or select the desired cell and then press F2. 
Once in Edit mode, you can place the insertion point wherever you like, in the cell or the Formula 
Bar, and edit the existing data as you normally would in a word-processing application. Once you've 
edited the data, regardless of where the insertion point is, you can press either Tab or Enter to enter 
the data and navigate to the desired next cell.

Presenter
Presentation Notes
To enter data in a cell and keep that cell as the active cell, press Ctrl+Enter to enter the data. Also, you can use the Up, Down, Left, or Right arrow key to enter data and then navigate one cell in the desired direction.



Use Excel Commands
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Ribbon Element Description

Tabs Organize the ribbon at the highest level according to task functions such as inserting 
objects, working with formulas, and configuring the view of your worksheets.

Groups Contain functionally related sets of commands that you will use to perform most Excel 
tasks.

Commands Execute the desired action or configure the desired settings and options.

Dialog box launchers Open dialog boxes containing further commands or options related to the functionality 
of the group's commands.

Search Allows you to perform a keyword search for Excel commands.

The Ribbon
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Presenter
Presentation Notes
The ribbon, a common interface element shared by all Microsoft Office 2021 applications, is a component of the Excel 2021 UI.



Ribbon Tab Contains Commands For

File Working with your Excel files and configuring system-wide and application settings and options. Selecting the 
File tab accesses the Backstage view, providing you with access to these commands and settings.

Home
Executing some of the most common Excel tasks. The Home tab displays commands for basic text formatting 
and editing; applying various styles and formatting to your data; and sorting, filtering, and searching your 
data.

Insert Inserting a variety of objects, such as charts, tables, and graphics, into your workbooks; creating and editing 
hyperlinks; adding headers and footers to worksheets; and inserting equations and symbols.

Page Layout Applying themes and effects to worksheets; configuring the overall layout of your worksheets; and arranging 
worksheet objects.

Formulas Inserting and working with formulas and functions; naming cells and ranges; troubleshooting workbook data, 
functions, and formulas; and setting calculation options.

Data Importing data from other sources; performing various data analysis tasks; and organizing worksheet data into 
a hierarchical structure.

Review Reviewing, proofing, adding comments to, and sharing your workbooks.

View Configuring workbook views, viewing multiple workbooks simultaneously, and setting the magnification level.

Help Searching the documentation, contacting support, providing feedback, suggesting a feature, and accessing 
Microsoft resources such as the user community and the blog.

The Ribbon Tabs
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Search
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• By typing text into the Search text box, Excel will return several of the most relevant search results in a 
drop-down menu; each keystroke will update the results on-the-fly, so the more information you provide in 
your search, the more likely the Search feature is to show you what you're looking for.

Presenter
Presentation Notes
Additionally, when you place your insertion point in the Search text box, a Recently Used Actions section of the drop-down menu will automatically display the last three commands you searched for and executed



ScreenTips and KeyTips
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• ScreenTips appear when you place the mouse pointer over commands and some other elements of 
the UI. ScreenTips appear in a small pop-up window and provide information such as a command's 
name, a description of what the command or screen element does, and the keyboard shortcut that 
performs the same function.

• KeyTips appear along the ribbon and the Quick Access Toolbar when you press the Alt key. KeyTips 
appear as either a single alphanumeric character or a sequence of them.

Presenter
Presentation Notes
It is important to note that KeyTips do not function the same as keyboard shortcuts. If a KeyTip is displayed as a sequence of characters, you press the corresponding keys one at a time, not at the same time as you would with a keyboard shortcut such as Shift+Enter.



The Quick Access Toolbar
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• The Quick Access Toolbar is another element of the Excel UI that provides you with easy 
access to commonly used commands. The Quick Access Toolbar appears above the 
ribbon in the top-left corner of the Excel UI. By default, the Save, Undo, and Redo 
commands appear on the Quick Access Toolbar. Like the ribbon, the Quick Access 
Toolbar can be customized.



The Mini Toolbar and Context Menus
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• In Excel 2021, there are actually multiple versions of the Mini toolbar: the main version 
that is displayed when you right-click an active cell, and variations of the main Mini 
toolbar that are displayed when you right-click various other objects on worksheets, such 
as images and charts.



Create and Save a Basic Workbook
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The New Tab
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The Backstage view's New tab provides you with a variety of options for creating new Excel 
workbooks. You can create a new blank workbook to start from scratch, or you can decide 
to start with an existing Excel workbook template, and then make changes to suit your 
needs.



The Excel 2021 Backstage view.
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The Backstage view's New tab provides you with a variety of options for creating new Excel 
workbooks. You can create a new blank workbook to start from scratch, or you can decide 
to start with an existing Excel workbook template, and then make changes to suit your 
needs.

New Screen Element Is Used To

Search for online templates field Enter search criteria to look for available Excel workbook templates 
from Office.com.

Start searching button Execute a search based on the search term(s) entered in the Search 
for online templates field.

Suggested searches section
Search for Office.com templates in a variety of commonly searched 
categories. These categorized searches are also broken down into sub-
categories for more precise searching.

Blank workbook tile Create a new, blank workbook.

Template tiles Create new Excel workbooks based on the selected template.



File Type and Extension Description
Excel Workbook (.xlsx) The default file type in Excel 2021.
Excel Macro-Enabled 
Workbook (.xlsm) Allows you to save workbook files containing Visual Basic® for Applications macrocode.

Excel Binary Workbook 
(.xlsb)

Compressed, binary-based file format that reduces file size and improves performance in 
complex, calculation-dense workbooks. This file type may not be compatible with some 
applications that work only with XML-based files.

Excel 97-2003 Workbook 
(.xls)

The previous default Excel file format. The XLS format is a binary file format, which isn't as 
compatible with other computer applications as the newer, XML-based file format.

Excel Template (.xltx) The default file type for Excel templates. This format is used to save workbooks as templates 
so that you can create new workbooks based on the template contents, layout, and format.

Excel Macro-Enabled 
Template (.xltm) The default file format for Excel macro-enabled templates.

Excel 97-2003 Template (.xlt) The default template file format in prior versions of Excel.

PDF (.pdf) Allows you to save workbooks in the Portable Document Format (PDF).

Excel 2021 File Formats
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The Save and Save As Commands
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Excel provides you with two options for saving your new and existing workbook 
files: 
• The Save command—save changes to an existing workbook without 

changing the file name or the file location.
• The Save As command—save new workbook files or to make changes to 

existing files, such as the file name and location.
• Both the Save and Save As commands are accessible in the left pane in the 

Backstage view. The Quick Access Toolbar also provides access to the Save 
command by default.

• If you select Save to save a new workbook file, Excel 2021 automatically 
displays the Save As screen, as you must specify a location and a file type 
when saving new files.



The Save As Screen
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The Save As screen contains the commands and options you will use to select a location to 
save your workbook files, either on your computer, on an attached storage device, or in a 
remote location such as a network share or an online file storage service.



Save As Option Description
Recent This option provides you with a list of recent and pinned folders.

OneDrive

This option provides you with direct access to your personal Microsoft OneDrive® account, if 
you have one. OneDrive is a file storage and sharing service that enables individuals to store 
files online (or "in the cloud") for easy access from any location that has Internet 
access.There are two versions of OneDrive: personal and business. Anyone can create a 
personal Microsoft account with OneDrive, and it is free to sign up. It is possible that your 
Office 2021 administrator will block usage of personal accounts for your organization. 
OneDrive for Business is only included with Microsoft 365, not Excel 2021.

This PC

This option acts as a shortcut to display a list of locations that you've recently saved your 
workbooks to. The shortcuts are divided into various sections based on time, such as Today, 
Yesterday, and Last Week. Selecting one of the shortcuts opens a Save As dialog box to that 
location. In this dialog box, you can name your file and select the appropriate file type.

Add a Place You can use this option to add other options for workbook file storage, such as network 
servers, OneDrive, and Microsoft SharePoint® sites.

Browse
This option immediately opens the Save As dialog box to your local Documents folder, or to 
the current workbook's location if it has already been saved. You can use this option to 
quickly browse to a specific location where you want to save your workbook.

The Save As Options
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Compatibility Mode
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When you open a workbook file in Excel 2021 that was created by using Excel 2003 (or an 
earlier version), Excel opens the file in Compatibility mode and the Title bar displays the file 
name with the text [Compatibility Mode] next to it. You can open and work with files in 
Compatibility mode to preserve the original file format, allowing you to subsequently open 
the file in previous versions of Excel. Keep in mind that some Excel 2021 features are not 
available in all versions of Excel.



The Convert Option
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When you open a workbook in Excel 2021 that was created in a 97-2003 version of Excel, 
and you no longer need to keep the workbook in the previous file format; you can convert 
the workbook into the current XLSX format. Using the Convert option provides you with 
access to all of the features and functionality available in Excel 2021. Often, converting a file 
to the newer file format will also reduce the size of your workbook file.

When you convert a workbook, Excel replaces the old file with a copy of the workbook in 
the XLSX or the XLSM file format. The previous version of the file is no longer available for 
you to work with. You can access the Convert option from the Info tab in the Backstage 
view of any workbook that is open in Compatibility mode.



The Compatibility Checker
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The Compatibility Checker allows you to test the compatibility of objects and data in an 
Excel 2021 workbook when you intend to save it in an earlier Excel file format. This is typical 
when you need to share a file you created in a newer version of Excel with a user who has 
an older version of Excel installed on their machine.

Selecting the Check Compatibility command opens the Microsoft Excel - Compatibility 
Checker dialog box, in which you can view a list of features in your Excel 2021 file that are 
not supported in earlier versions of Excel. You can access the Check Compatibility 
command by selecting File → Info → Check for Issues. Excel will also run the Compatibility 
Checker automatically when you attempt to save a current Excel workbook file in the 
previous file format.

Unchecking the Check compatibility when saving this workbook check box allows you to 
save in previous versions without the Compatibility Checker running automatically. 
However, be careful when you uncheck this feature; you will lose certain functionality when 
you save back to previous versions.



Enter Cell Data
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It's Not WYSIWYG
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One of the most fundamentally important things to understand about Excel is that it is not 
a "what you see is what you get" (WYSIWYG) type of environment. Often, the value or text 
that appears within a cell is not what is actually stored in the cell. A simple example of this 
is the result of a calculation. If you have a formula entered in a cell, by default, the cell will 
display the result of the formula. For example, if the cell contains a formula that is the 
equivalent of "1 + 1," the cell will display the result of that formula: 2. But 2 is not the 
actual cell data; the formula is. Although this may, at first, not seem highly important, as 
you begin to work with the more complex functionality in Excel, it will become a critical 
concept to understand.

Presenter
Presentation Notes
When you're in Edit mode, the cell displays its actual content, similar to the way the Formula Bar displays cell content. So if a cell contains a formula, while you edit the content, the cell displays the formula. When you're in Enter mode, Excel displays the formula result in the cell.



Data Category Description

Values Numeric constants that do not change unless you edit the cell 
contents. Examples include 1, 345, 11.6, and .002.

Labels/text
Alphanumeric text not used to perform calculations or store numeric 
values. These can largely be viewed as labels for related sets of data on 
a worksheet. Examples include "Sales," "Q1," and "Total."

Formulas
Mathematical equations used to perform calculations or data analysis. 
Formulas are dynamic, so the displayed value can change if you change 
the cell data "feeding" the formula.

Dates and times Date and time values. These can be used both as simple labels or as 
part of certain mathematical or logical operations.

Data Types
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Although Excel cells can contain an incredible array of content, there are really only a few 
general categories of data that you'll work with on a regular basis.



The Cut, Copy, and Paste Commands
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Although Excel is different from other Office applications such as 
Word and PowerPoint®, you'll find some of the functionality is quite 
similar. The Cut, Copy, and Paste commands are a good example of 
this. You will use the Cut, Copy, and Paste commands either to make 
a copy of cell data and place it in another cell, or to remove data 
from one cell and put it in another.

Command Performs This Action

Cut Removes data from the selected cell or removes the selected 
data, and places a copy of it on the clipboard.

Copy Makes a copy of the data in the selected cell or a copy of the 
selected data, and places the copy on the clipboard.

Paste Places the data that was most recently added to the clipboard in 
the destination cell or location.

Presenter
Presentation Notes
Copied data is temporarily stored on a Microsoft Office tool known as the clipboard. Data on the clipboard can be reused in other locations on the same worksheet, within the same workbook, and in other workbooks and applications. The Cut, Copy, and Paste commands are displayed in the Clipboard group on the Home tab.




Drag-and-Drop Cut and Paste
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In addition to using the Cut, Copy, and Paste commands to move content, you can use 
Excel's drag-and-drop editing functionality. When you select a cell or a range, the cell or 
range is displayed with a solid green border around it. If you place the mouse pointer over 
the green border anywhere other than above the fill handle, Excel displays the mouse 
pointer as a move icon.  When the move pointer appears, you can click and drag the 
selected cell or range and drop it in place anywhere else on the worksheet. This effectively 
cuts and pastes all content within the selection to the new location.

If you press and hold down the Ctrl key while performing this procedure, the mouse pointer 
changes into the copy pointer. By using the copy pointer, you can drag a copy of the 
content in the selected cell(s) to a new location. This is the same as copying and pasting the 
content.



The Undo and Redo Commands
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Inevitably, as you work with Excel, you will make a mistake. Fortunately, Excel, like many 
other Office applications, provides you with the Undo and Redo commands to help you 
correct errors as you work. The Undo command will cancel out the last action you 
performed, or the last several actions you performed, so you can correct any mistakes 
you've made while working with your workbooks. The Undo command works on a wide 
variety of actions, including entering data/typing text, performing calculations, adding 
objects to your worksheets, and formatting worksheets and worksheet objects. Once 
you've used the Undo command, Excel activates the Redo command, which will cancel out 
the last undo action or a series of undo actions.
By default, the Undo and Redo commands are available on the Quick Access Toolbar.
The keyboard shortcuts for Undo and Redo: Ctrl + Z and Ctrl + Y, respectively.



The AutoFill Feature
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Excel 2021 includes a number of features meant to make your life a bit easier. One of these 
is the AutoFill feature. The AutoFill feature attempts to recognize an existing pattern in the 
data you have already entered, and then apply that pattern to filling in additional cells.

To use the AutoFill feature, you must first select the 
sequence of cells you want the pattern to be based 
on. When you select a cell or a range, Excel displays 
the cell or range within a solid green border. At the 
bottom-right corner of the border, Excel displays a 
fill handle. To use the AutoFill feature, you simply 
drag the fill handle until the border surrounds the 
desired range of cells, and then release it. When the 
mouse pointer is directly over the fill handle, it is 
displayed as a thin black plus symbol. 



AutoFill Options
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AutoFill Option Description

Copy Cells
Ignores any recognizable pattern and fills the remaining cells with the same data the 
originally selected cells contain. For example, you could use Copy Cells to repeat the 
values 1, 2, 3 in the rows below to prevent Excel from making these new values 4, 5, 6.

Fill Series The default AutoFill option. Excel applies the pattern it recognizes in filling the 
remaining cells.

Fill Formatting Only Applies any formatting in the originally selected cells to the remaining cells without 
populating the cells with content.

Fill Without Formatting Fills the remaining cells with data based on the recognized pattern while ignoring any 
formatting applied to the originally selected cells.

Flash Fill Fills in cells following a pattern in one column that is based on the cells in the same 
row in other columns.

Presenter
Presentation Notes
Excel 2021 also provides you with several options for deciding how to apply AutoFill when you use the feature. After you release the fill handle, Excel displays a small icon on the lower-right side of the range. Selecting that icon opens a menu, providing you with access to a series of options for choosing how to apply the AutoFill. These options can change depending on the type of data you have entered into the range.




Flash Fill
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In addition to being an AutoFill option, the Flash Fill feature can automatically recognize 
patterns across rows as you enter data, and then copy those patterns down a column of 
entries. The key difference between this and the AutoFill feature is that it depends on a 
recognizable pattern based on the entries in cells in other columns.

The Flash Fill feature cannot recognize patterns in 
a column and then copy the pattern across a row. 
It works only down columns.

The Flash Fill feature will work only if there are no 
empty columns between the original data and the 
column you're trying to fill following a pattern. 
There can, however, be columns of data that 
don't relate to the pattern in between the cells 
containing the original data and the cells you are 
trying to fill.

Presenter
Presentation Notes
A feature which automatically recognizes patterns across rows as data is entered, and then copies those patterns down a column of entries.



The Clear Command
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Because you need to enter data into worksheet cells, it stands to reason that you will also 
need to delete cell data from time to time. The most basic method of doing this is to select 
the cell that contains the data you wish to remove and then press the Delete key. Excel also 
provides an alternative with the Clear command, which gives you access to a number of 
options for removing cell content that don't always include removing everything from the 
cell. The Clear command is available in the Editing group on the Home tab.
Clear Command Option Clears
Clear All Everything from the selected cell(s).

Clear Formats Only formatting applied to the selected cell(s). The content is left in place, 
including any existing comments.

Clear Contents Only the contents of the selected cell(s), but not the formatting.
Clear Comments Only comments from the selected cell(s).

Clear Hyperlinks Hyperlinks from cell contents. The formatting is left in place, including formatting 
applied to the text when the hyperlink was created.

Remove Hyperlinks Hyperlinks and all formatting.

Presenter
Presentation Notes
A feature which automatically recognizes patterns across rows as data is entered, and then copies those patterns down a column of entries.



Use Excel Help
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Microsoft Excel Help
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Microsoft Excel Help provides you with access to articles that can answer your Excel 
questions and show you how to perform various tasks within the application. Excel Help 
checks Microsoft Office's support website for these articles, which can include text, 
screenshots, and video. In order to access Help articles, you must have an active Internet 
connection.

To access the Excel Help system, press the F1 key or select Help → Help. You can also reach 
Help on specific topics by searching for the topic in Search, or you can select the Microsoft 
Excel Help button in the top-right corner of the Excel UI while in the Backstage view. This 
opens your web browser to a Help article on that particular Backstage command.

Presenter
Presentation Notes
A feature which automatically recognizes patterns across rows as data is entered, and then copies those patterns down a column of entries.
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When you open the Excel Help system, Excel displays the 
Help task pane. You can use the Help task pane to search 
for, browse through, and review the various web articles 
available to you. 
The Help task pane is divided into a number of sections 
and displays a variety of commands to help you locate 
the desired Help resources. The following table describes 
each of these in some detail.

Help Task Pane Element Is Used To

Help toolbar Navigate back through Help search results and go to the Help 
home page.

Search field Enter search terms for locating Help resources.
Search button Execute Help searches.

Content section Display the results of a search or the contents of an online Help 
article.
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